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Welcome to the USGS Office of Surface Water Hydroacoustics podcast, an introduction to extrap version 3. 
This podcast is similar to an earlier version but is update to introduce the new interface and features in extrap 
version 3. Even if you have viewed the previous version you will want to continue with this podcast as version 
3 of extrap is much different and much more efficient to use than version 1. 
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This introduction to extrap 3 will cover the Purpose of extrap; the shape and distribution of velocity profiles in 
rivers; how profiles are averaged in WinRiver; how profiles are averaged in extrap; and then provide a detailed 
description of the extrap interface and how to use it. 
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The purpose for extrap is to provide the user a technically correct and efficient method to statistically and 
visually determine the best extrapolation method to use for computing discharge in the unmeasured top and 
bottom portions of an ADCP discharge measurement. One of the keys here is efficient; extrap should be faster, 
more accurate, and easier to use than completing the analysis using WinRiver or RiverSurveyor. 
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The distribution of velocity in a channel cross section is dependent on the roughness of the bed and bank and 
also the shape and width to depth ratio of the channel. This diagram from Chow's Open Channel textbook 
shows the velocity distribution in several different channel shapes. For the narrower and deeper channels you 
can see that the region of maximum velocity is located below the water surface this would result in a velocity 
profile that tends to bend back near the top as shown hear. This bend back is not due to wind or density 
currents but simply the channel shape. For wider and shallower cross sections the velocity profile follows the 
more typical logarithmic or power curve. 
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In addition to the shape of the cross section, the roughness of the streambed can also have a significant 
impact on the shape of the velocity profile. This graph plots the normalized depth and velocity for three 
velocity profiles with different values or relative roughness. The relative roughness is computed as the depth 
of flow divided by the height of the roughness so that the smaller the relative roughness the greater the actual 
roughness and hence the drag on the flowing water. The curve with the smoothest bed shows greater velocity 
nearer the bed and a steeper profile than the curves with greater roughness. As the bed roughness increases 
the drag on the water increases and the velocity near the bed decreases while the velocity near the surface 
increases. Therefore, as the roughness increases the velocity profile will tend to become flatter. 
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When using WinRiver the recommended process was to average ensembles together to reduce the effects of 
instrument noise and turbulence so that the shape of the velocity or discharge profile could be evaluated 
more accurately. However, WinRiver simply averaged data in the same depth cell across multiple ensembles. 
Typically we suggested using about 10 ensembles in the average. If we look at two portions of this cross 
section each representing about 10 ensembles we can illustrate the potential problem in using this technique. 
Averaging the cells at the surface doesn't illustrate the problem very well and actually seems like a reasonable 
thing to do. However, if we look near the bed in an area were the depth is changing we can see that by 
averaging across constant depths we average data very near the streambed that would have a lower velocity, 



with data further from the streambed that would naturally have a greater velocity rather than with data in the 
same relative proximity to the bed. The result can be a distorted velocity profile. 
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Extrap uses only normalized or relative values of velocity, discharge, and depth. Use of normalized velocity and 
discharge for each ensemble allows all data from the cross section to be plotted together and the use of 
normalized depth accounts for the changes in the depth of flow. Extrap then computes the median values for 
5% depth increments. The horizontal whiskers are added to the median values to show the spread of 50% of 
the data in each increment. 
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The supported data structures for extrap 3 have been expanded compared with extrap 1. Extrap 3 supports 
the Rio Grande, StreamPro and RiverRay ADCPs from Teledyne RD Instruments and the RiverSurveyor M9 and 
S5 ADCPs from SonTek. A major enhancement in extrap 3 is the ability to simultaneously load all the transects 
that comprise a measurement. To make this efficient for TRDI ADCPs, extrap allows loading the mmt file which 
will automatically load all checked transects with the recorded instrument depth. The loading of one or more 
pdO binary data files is still supported, but the user will have to manually enter the instrument depth for each 
pdO file. Data collected with RiverSurveyor M9 and S5 ADCPs must be processed with RiverSurveyor Live to 
create the Matlab output data files. Extrap can load one or more RiverSurveyor Live Matlab output data files. 
NOTE: Extrap is designed for moving-boat measurements and does not currently support data files collected 
with the manufacturer's mid-section measurement software. 
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The extrap user interface consists of: 

 Menus to load files, save data, and configure the profile graph The profile graph 
 A Toolbar that can be used to 200m and pan on the profile graph A table that shows the location and 

number of points in each median value A control to show what data has been loaded and is displayed 
Extrapolation fit options 

 A table containing a discharge sensitivity analysis for various fit options 
 A message area 
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To load an mmt file and all associated transects, click on the File menu and then Open TRDI *.mmt. Navigate 
to the folder with the files you wish to open and either double click on the mmt file or click on the file and click 
Open. Extrap will read the mmt file and then begin reading the individual transects. The red bar shows the 
progress on each transect and the blue highlight in the Data and Fit Controls indicates which transect is being 
read. When all transects have been read the automatic fit information will be displayed. 
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To load individual pdO files, click on the File menu and then Open TRDI *.pdO, *r.000. Navigate to the folder 
containing the data. Using click followed by a shift click you can select a consecutive block of files or by using 
click and control click you can select multiple files that are not listed consecutively. Click Open to load the files. 
The user will be prompted to indicate the units that will be used to enter the draft or depth of the transducer. 
In this example, we will use feet. The user will then be prompted to enter the draft for the first transect. The 



user will then be prompted to enter the draft for each of the subsequent transects, but the value from the 
previous transect will be used as the default. Once the draft for all transects has been entered, each transect is 
read. Again, the red bar shows the progress on each transect and the blue highlight in the Data and Fit 
Controls indicates which transect is being read. When all transects have been read the automatic fit 
information will be displayed. 
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To load RiverSurveyor data the data must first be processed in RiverSurveyor Live and the Matlab output files 
generated. To generate the Matlab output from RiverSurveyor Live, open the transects in RiverSurveyor Live, 
then open the Processing Toolbox and click the Matlab icon and then Matlab Export AIL In extrap, click the File 
Menu and Open SonTek *.mat. Navigate to the folder containing the data. Using click followed by a shift click 
or click followed by control click select the files you want to process. Click Open to load the files. Because 
these are Matlab files they should load very quickly. When all transects have been read the automatic fit 
information will be displayed. 
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The most prominent part of the user interface is the profile graph. It is important to understand what all of the 
symbols and lines in this graph represent. The gray dots represent the normalized discharge for each depth 
cell in the transect plotted at the appropriate normalized depth. The blue squares represent the median value 
for data falling within a 5% increment of normalized depth. The blue horizontal lines or whiskers show the 
limit of the central 50% portion of the data used to compute the median. The black squares are the median 
values for the 5% increments from a composite of all of the loaded transects. The magenta curve is the 
extrapolation fit based on the data and the user provided parameters for each left to right transect. The blue 
curve is the extrapolation fit based on the data and the user provided parameters for each right to left 
transect. The black curve is the extrapolation fit based on the data and the user provided parameters for the 
composite of all transects. The data in red show the median and interquartile ranges for 5% increments of 
depth where the number of points in the increment are below the threshold for the minimum number of 
points for a valid median point. 
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Although we have described the lines and symbols in the default profile graph the user can change and control 
what is displayed. To display individual transects click on the desired transect in Data and Fit Controls. By 
default the composite fit is displayed along with the fit for the individual transect. To turn off any of the 
symbols or lines in the profile graph click the View Menu and check or uncheck the various features. To 
eliminate the composite median values, simply uncheck the Measurement Median. Note these changes apply 
to the graph and not the transect. Changing to a different transect or back to the measurement will retain the 
setting. It is sometimes helpful in evaluating the profile to know which cells are actually the first or upper most 
cell. Click view and Highlight Surface Cells and all the 1“ cells in each ensemble will be highlighted with a green 
circle. Note: the surface cells are not always to top cell when the depths are normalized. If cells were located 
at 0.3 and 0.4 ft below the surface in a location that is 10 ft deep they would plot at normalized depths of 0.03 
and 0.04. However if the depth were only 2 ft they would plot at normalized depths of 0.15 and 0.2. So the cell 
in the 10 ft deep water located 1.5 ft below the surface would plot in the same normalized location as the cell 
located 0.3 ft below the surface with a water depth of 2 ft. 
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The icons in the toolbar can be used to zoom, pan, and probe the data in the profile graph. To zoom in on a 
specific area, click the magnifying glass with the + sign and then click and drag a box over the desired portion 
of the profile graph. Clicking on the hand allows you to pan in the profile graph, by holding down the left 
mouse button and dragging in the profile graph. To determine a value of a point in the graph you can use the 
data probe tool which appears as a + with a yellow box in the toolbar. Click the data probe icon in the toolbar 
and then click a point in the graph window and the coordinates of that point will be displayed. To modify or 
remove a data tip, right click on the data tip and select the desired option. To stop data probing click the data 
probe icon in the toolbar again. To zoom out click the magnifying glass with the - sign and then click one or 
more times in the profile graph. 
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Although the logic in extrap 3 attempts to select an appropriate extrapolation fit for you, you should always 
visually evaluate the selected fit. You can change the fit by first changing the Fit from Automatic to Manual 
and then selecting a new top and/or bottom method by selecting from the available methods in the Top and 
Bottom controls. If you select no slip as the bottom method the top method automatically changes to 
constant. To change the exponent you can manually enter a different value or use the slider bar to change the 
value by specified increments. The chosen fit only applies to the data shown, in this case the composite of all 
transects in the measurement. If I change to one of the transects the Fit will still be Automatic. 
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The Set Pt Threshold sets the number of points that must be present in each S% normalized depth increment 
for that data in that increment to be used in fitting the chosen extrapolation method. Changing this value will 
result in more or less median values being considered in the extrapolation fit. Those not considered are 
plotted as red. The minimum number of points for a median value to be considered valid is based on a 
percentage of the median number of points for all of the increments. 

The default percentage is 20%. This default value can be changed by the user by clicking the Configure Menu, 
threshold and entering a new number. After a new threshold is entered the data are reprocessed to reflect the 
new threshold. 
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extrap was designed to be used with moving-boat discharge measurements but can be used to evaluate 
stationary profiles by changing the data type to velocity. Note: this feature is for stationary data collected as a 
transect in the moving-boat software and not for data collected using mid-section specific software. When 
velocity is selected as the data type the Discharge Sensitivity is disabled. 
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extrap has limited ability to subsection the data to look only at a portion of the cross section. This 
subsectioning is based on a percentage of discharge and does not account for direction of the transect. To 
look at the center 50% of the flow you would click Configure then Subsection and enter 25% as the lower limit 
and 75% as the upper limit. An enhancement in future versions will account for the direction of the transect so 
that the percentages are applied consistently from one bank. 
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The discharge sensitivity analysis is new to extrap 3 and can be a useful tool for determining both how 
important the extrapolation method is and what the potential error due to the unmeasured top and bottom 



may be in the rating of the measurement. The table assumes that the power fit with a l/6,h exponent is the 
reference and then computes the difference from this reference for other fit options. For this example we can 
see that there is a bend back near the surface and that a constant fit at the top and no slip at the bottom is 
appropriate. Looking at the table we can see that if the default were retained in our measurement we would 
have an error of about 3.7% from the automatically selected fit of constant/no slip with an optimized 
exponent. This difference is not huge but certainly significant. If we agree that power at the top is not 
appropriate then our decision is between constant and 3-pt at the top and no slip with the default or a least 
squares fit exponent at the bottom. The maximum difference among these options is about 1.5%. The 
automatic logic selected Constant / No Slip with an exponent of 0.3157, which would need to be entered in to 
the manufacturers software to compute the final discharge. In the rating of this measurement, we could 
assume a maximum uncertainty associated with the unmeasured areas at the top and bottom of about 1.5%. 

For this next example, the automatic mode selected power / power with an exponent of 0.3057. However, 
evaluating the sensitivity of this measurement to the extrapolation methods we see that all methods are 
within about 1%. Generally changes in discharge greater than 1% should be addressed so the new exponent 
should be entered in the manufacturers software. In the rating of this measurement, we could assume a 
maximum uncertainty associated with the unmeasured areas at the top and bottom of less than 1%. 
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Extrap may display two messages in the message area near the bottom of the window. The first message will 
appear when TRDI data are loaded. This message is to remind the user that for TRDI ADCPs extrap only uses 
bottom track referenced data. Because the data are normalized the evaluation of the extrapolation is not 
affected by a moving bed. However, if bottom track is invalid, those ensembles with invalid bottom track will 
not be used by extrap, even though they maybe valid when using GGA orVTG for the final discharge 
computation. Therefore, user judgement is necessary when a significant portion of the channel has invalid 
bottom track. 

In addition, WinRiver 2 has limits on the value of the exponent that may be entered by the user. It is possible 
the extrap may recommend an exponent greater than WinRiver 2’s limit of 0.5. In such a situation, the user 
should manually enter 0.5 in extrap and evaluate the discharge sensitivity to determine the best methods and 
exponent for the measurement. 

Finally, extrap does not allow manual or automatic selection of the 3-point top extrapolation, but it does 
determine if the data are such that a 3-point fit might be appropriate and provides a message in the message 
area indicating the user should consider this option. The discharge sensitivity analysis always includes the 3-
point top method for reference. 
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After completing the analysis using extrap the results can be saved to a text file. Click File, Save Summary. The 
user will be presented with a dialog that allows them to enter comments associated with the extrapolation 
evaluation. The saved file is named using the date and time followed by _extrap.txt and is saved in the same 
folder as the data. 
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Extrap is only an evaluation tool, it does not communicate with WinRiver 2 or RiverSurveyor Live. You, the 
user, must manually enter the selected top and bottom extrapolation method and exponent into the 
manufactures software and reprocess the data to achieve a final discharge. The extrapolation settings in 



WinRiver 2 can be changed by double clicking on the Playback node in the Measurement Control and going to 
the Discharge property tab. Then use the apply all or apply all checked feature to apply the settings to all 
transects in the measurement. The extrapolation settings in RiverSurveyor Live can be change by opening the 
Processing Toolbox and going to Profile Extrapolation. For a power fit at the top and bottom with an exponent 
different from 0.1667 the exponent must be changed in two locations as indicated. 
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Let's look at two application examples. This first example shows some rather noisy data. Too illustrate how 
noisy the data are I have turned off all the graphic features except for the raw data. Different from other 
examples shown in this presentation, absent the median points it is difficult if not impossible to identify even a 
general pattern from the raw data. Turning on the measurement points we see a near vertical profile with an 
irregular shape. So what is the best fit? The automatic algorithm selected constant no slip with the l/6m power 
exponent for the no slip portion. The other option that seems reasonable would be the power-power fit with 
the 0.09 exponent. Looking at the discharge sensitivity analysis we see there will be difference of about 4% 
between power-power and the constant no slip. So what should I chose? This is where your knowledge of the 
site and river mechanics is important. If you know the site has a smooth streambed clay or concrete lined 
channel you would expect little drag on the bed and the power/power with the 0.0914 exponent might be the 
best fit. However, if this site had a typical sand or gravel bottom you would expect more drag from the bed 
and you might choose constant / no slip with the l/6,h exponent. The computer can only evaluate that data 
and if the data do not show a consistent pattern your knowledge of the site and hydraulic conditions are 
critical in choosing the correct fit. 
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In this second example we can clearly see that the data display a much flatter profile than the default l/6’h 
exponent. The automatic algorithm selected a 0.6315 exponent. However, careful examination of the data 
shows there is a tendency for the top and bottom couple of bins to tend more towards vertical. Therefore, if 
we override the automatic fit and look at constant / no slip with a no slip exponent of 0.4939 we see that this 
fits the data very well. So, which do we select? Again, your knowledge of the site and conditions is critical. If 
there was an upstream wind or this channel has a rather narrow width to depth ratio then I would lean 
towards the constant no slip as I would expect the maximum velocity to be below the surface. However, if 
there was no wind and no reason for slower velocities at the surface I might stay with the recommendation for 
the automatic algorithm and use a power fit with a 0.6315 exponent. The good news for this particular 
example is that when we look at the discharge sensitivity table there is essential no difference in discharge 
between our two choices. 
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The steps for using extrap are: 

 Load and process all of the transects in the measurement  
 Visually verify the automatically selected fit and change if necessary  
 Don't over analyze 
 Consider the effect of the fit on total discharge using the discharge sensitivity analysis  
 Consider the noise indicated the spread of the gray dots and the whiskers on the median values  
 Select a SINGLE "best fit" for the whole measurement 



This approach should save you time, not require more time than evaluating the fit using the WinRiver 2 or 
RiverSurveyor Live graphics. 
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If you have questions on this or other hydroacoustic issues you can email me at dmueller@usgs.gov or visit 
our hydroacoustics website or become a member or our forum, if you aren't already, and ask your question or 
share your insights with others. 


